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Function

t key Functions as shown in the bottom left of the 
LCD screen.

ft key Functions as shown in the bottom right of the 
LCD screen.

reen Displays the printer status messages, and the 
panel settings.

button Press to start printing.

l button Press to cancel the printing or settings.

on Functions as shown in the LCD screen.

 4-way 
utton

Press to move the cursor on the LCD screen.

utton Press to enter the Menu mode for the print 
settings or maintenance options.

utton Press to open the front cover.

lay Press to change the view of the screen.

button Press to turn the printer on and off.

ight On when the printer is turned on and ready.
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Printer Parts

Top cover: Holds the blank 
paper straight.

Edge guides: Help load the paper 
straight. Adjust the both edge guides to 
fit the width of your paper.

Paper feeder: Holds your 
paper and feeds it for 
printing.

Handle

Memory card light

Memory card slots

Front cover: Receives the ejected 
paper. Open the cover to inert or 
eject a memory card.
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EXT. I/F (USB) port: Used to 
connect the printer to the 
optional Bluetooth Photo 
Print Adapter and digital 
cameras that have USB 
DIRECT-PRINT functionality.

DC inlet

Photo cartridge lever

Cartridge compartment cover
USB port for computer: Used 
to connect the computer and 
printer together using the 
USB cable.

Photo cartridge

Battery cover: Remove the cover 
to insert an optional battery.
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Photo Printer

No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without the prior 
written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson printer. Epson 
is not responsible for any use of this information as applied to other 
printers.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the 
purchaser of this product or third parties for damages, losses, costs, or 
expenses incurred by the purchaser or third parties as a result of 
accident, misuse, or abuse of this product or unauthorized 
modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with Seiko Epson Corporation's operating 
and maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or 
problems arising from the use of any options or any consumable 
products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage 
resulting from electromagnetic interference that occurs from the use of 
any interface cables other than those designated as Epson Approved 
Products by Seiko Epson Corporation.

EPSON® is a registered trademark and PictureMate™ is a trademark 
of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are 
trademarks of Seiko Epson Corporation. Copyright © 2001 Seiko Epson 
Corporation. All rights reserved.
USB DIRECT-PRINT™ and the USB DIRECT-PRINT logo are 
trademarks of Seiko Epson Corporation. Copyright © 2002 Seiko Epson 
Corporation. All rights reserved.
Microsoft® and Windows® are registered trademarks of Microsoft 
Corporation.
Apple® and Macintosh® are registered trademarks of Apple Computer, 
Inc.
DPOF™ is a trademark of CANON INC., Eastman Kodak Company, 
Fuji Photo Film Co., Ltd. and Matsushita Electric Industrial Co., Ltd.
The BLUETOOTH™ trademarks are owned by Bluetooth SIG, Inc., 
U.S.A. and licensed to Seiko Epson Corporation.
Zip® is a registered trademark of Iomega Corporation.
SDHC™ is a trademark.
Memory stick, Memory Stick Duo, Memory Stick PRO, Memory Stick 
PRO Duo, MagicGate Memory Stick, and MagicGate Memory Stick Duo 
are trademarks of Sony Corporation.
xD-Picture Card™ is a trademark of Fuji Photo Film Co.,Ltd.
General Notice: Other product names used herein are for identification 
purposes only and may be trademarks of their respective owners. 
Epson disclaims any and all rights in those marks.
Copyright © 2006 Seiko Epson Corporation. All rights reserved.
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using 
your printer. Also, be sure to follow all warnings and 
instructions marked on the printer.

When choosing a place for the printer

Observe the following when choosing a place for the 
printer:

❏ Place the printer on a flat, stable surface that 
extends beyond the base of the printer in all 
directions. If you place the printer by the wall, 
leave more than 10 cm between the back of the 
printer and the wall. The printer will not operate 
properly if it is tilted at an angle.

❏ When storing or transporting the printer, do not tilt 
it, stand it on its side, or turn it upside down. 
Otherwise, ink may leak from the cartridge.

❏ Leave enough space in front of the printer for the 
paper to be fully ejected.

❏ Avoid places subject to rapid changes in 
temperature and humidity. Also, keep the printer 
and the AC adapter away from direct sunlight, 
strong light, water, or heat sources.

❏ Do not leave the printer in a place subject to high 
temperature, such as in a car. Also, keep the 
printer away from direct sunlight, strong light, and 
heat sources. Otherwise, the printer may be 
damaged or ink may leak.

❏ Avoid places subject to dust, shock, or vibration.

❏ Leave enough room around the printer to allow for 
sufficient ventilation.

❏ Place the AC adapter near a wall outlet where the 
plug can be easily unplugged.

❏ Do not place or store the printer and the AC 
adapter outdoors.
Safety Instructions 1



When setting up your printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in 
the printer.

❏ Power supply cords should be placed to avoid 
abrasions, cuts, fraying, crimping, and kinking. Do 
not place objects on top of power-supply cords 
and do not allow the AC adapter or power-supply 
cords to be stepped on or run over. Be particularly 
careful to keep all power-supply cords straight at 
the ends and the points where they enter and 
leave the AC adapter.

❏ Use only the power-supply cords that comes with 
this product. Use of another cord may result in fire 
or electrical shock, or injury.

❏ The AC adapter model A381H is designed for use 
with the printer with which it was included. Do not 
attempt to use it with other electronic devices 
unless specified.

❏ Use only the type of power source indicated on 
the AC adapter's label, and always supply power 
directly from a standard domestic electrical outlet 
with the AC power cord that meets the relevant 
local safety standards.

❏ Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly 
switch on and off.

❏ Avoid using electrical outlets controlled by wall 
switches or automatic timers.

❏ Keep the entire computer system away from 
potential sources of electromagnetic interference, 
such as loudspeakers or the base units of cordless 
telephones.

❏ Do not use a damaged or frayed power cord and 
the AC adapter.

❏ If you use an extension cord with the printer, make 
sure that the total ampere rating of the devices 
plugged into the extension cord does not exceed 
the cord’s ampere rating. Also, make sure that the 
total ampere rating of all devices plugged into the 
wall outlet does not exceed the wall outlet’s 
ampere rating.
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❏ Never disassemble, modify, or attempt to repair 
the AC adapter, power cord, printer, and options 
by yourself except as specifically explained in the 
printer's guides.

❏ Unplug the printer, and refer servicing to qualified 
service personnel under the following conditions:

The power cord or plug is damaged; liquid has 
entered the printer or the AC adapter; the printer 
or the AC adapter has been dropped or the casing 
damaged; the printer or the AC adapter does not 
operate normally or exhibits a distinct change in 
performance. (Do not adjust controls that are not 
covered by the operating instructions.)

❏ Do not use with wet hands.

❏ If you plan to use the AC adapter in Germany, the 
building installation must be protected by a 10 or 
16 amp circuit breaker to provide adequate 
short-circuit protection and over-current 
protection for this printer.

For United Kingdom, Singapore, and Hong Kong 
users

❏ Replace fuses only with fuses of the correct size 
and rating.

Safety requirements

Mains plug:
Use a 3-pin mains plug that is registered with the 
Safety Authority.

Flexible cord:
Use a double insulated flexible cord that is certified* to 
the relevant IEC or BS standards.

Appliance connector:
Use an appliance connector certified* to the relevant 
IEC320.

* certified by member of IECEE CB Scheme.
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For United Kingdom users

The following safety information applies to the AC 
adapter.

❏ Warning: Refer to the rating plate for the voltage 
and check that the appliance voltage corresponds 
to the supply voltage.

❏ Important: The wires in the mains lead fitted to 
this appliance are coloured in accordance with 
following code: Blue - Neutral, Brown - Live

If you have to fit a plug:

❏ As the colours of the mains lead of the appliance 
may not match the coloured markings used to 
identify the terminals in a plug, please observe the 
following:

The blue wire must be connected to the terminal 
in the plug marked with the letter N.

The brown wire must be connected to the terminal 
in the plug marked with the letter L.

❏ If damage occurs to the plug, replace the cord set 
or consult a qualified electrician.

When using the printer

Observe the following when using the printer:

❏ If you use the printer in places where the use of 
electronic devices is limited, such as in airplanes 
or hospitals, follow all instructions in those places.

❏ Do not insert objects through the slots in the 
printer.

❏ Take care not to spill liquid on the printer and the 
AC adapter.

❏ Do not put your hand inside the printer or touch 
the photo cartridge during printing.

❏ Do not use aerosol products that contain 
flammable gases inside or around this product. 
Doing so may cause fire.

❏ Always turn the printer off using the d On button. 
Do not unplug the printer or turn off the power to 
the outlet until the power light goes out.

❏ Before transporting the printer, make sure that the 
photo cartridge is in place.
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❏ Leave the photo cartridge installed. Removing the 
cartridge can dehydrate the print head and may 
prevent the printer from printing.

When using a memory card

❏ Use only memory cards compatible with the 
printer. See “Inserting a Memory Card” on page 20

When using LCD screen

❏ The LCD screen contains a few small bright or 
dark spots. These are normal and do not mean 
that the LCD screen is damaged in any way. 

❏ Only use a dry, soft cloth to clean the LCD screen. 
Do not use liquid or chemical cleansers. 

❏ If the LCD screen on your printer's control panel 
is damaged, contact your dealer. If the liquid 
crystal solution gets on your skin, wash them 
thoroughly with soap and water. If the liquid crystal 
solution gets into your eyes, flush them 
immediately with water. If discomfort or vision 
problems remain after a thorough flushing, see a 
doctor immediately. 

When using the optional Bluetooth Photo 
Print Adapter

Refer to the Bluetooth Photo Print Adapter's 
documentation for the safety instructions.

When using the optional battery

❏ If battery acid gets into your eyes or on your skin, 
immediately rinse the affected area thoroughly 
with water and seek medical treatment. If a battery 
is swallowed, seek medical treatment 
immediately.

❏ Use only an Epson Li-ion battery model D121A for 
this printer according to the directions in the user 
documentation. Replacing the battery with an 
incorrect model may cause an explosion.

❏ Use only AC adapter model A381H to charge the 
battery and operate the printer.

❏ Do not charge or use the battery with devices 
other than the specified product. Using the battery 
with other devices may damage the battery or 
other devices, or may cause an explosion.
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❏ To protect against short circuits, do not remove 
the outside case of the battery.

❏ Do not handle the battery with wet hands or use 
them near water.

❏ Do not expose the battery to water or high 
humidity.

❏ Do not drop, puncture, disassemble, mutilate, or 
short-circuit the battery.

❏ Do not place the battery near or into fire or water.

❏ Do not use the battery that is leaking or damaged 
in any way.

❏ Do not charge the battery on devices except this 
printer.

❏ Do not charge the battery near open flame or in 
very hot locations.

❏ Keep the battery away from heat sources.

❏ Do not leave the battery in a vehicle to prevent the 
battery from overheating.

❏ Do not insert objects into any openings as they 
may touch dangerous voltage points or 
short-circuit components.

❏ Prevent the battery from coming into contact with 
metal objects that could short-circuit it, such as 
coins or keys.

❏ Do not solder wires or terminals directly to the 
battery.

❏ Do not touch battery terminals.

❏ Keep the battery away from open flame if they leak 
or smell strange.

❏ If overheating, discoloration, or deformation 
occur, remove the battery from the printer and do 
not use it.

❏ Charge the battery before using it if it has not been 
used for a long period.
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When storing the optional battery 

❏ When not using the printer for a long period of 
time, remove the battery from the printer and store 
them separately to avoid over-discharging the 
battery.

❏ Do not store the battery where the temperature or 
humidity is very high.

❏ Store the battery out of children’s reach.

When disposing of the optional battery

Before disposing of the battery, make sure you 
discharge them completely.

w
Warning:
❏ Do not dispose of batteries as ordinary 

refuse. Instead, dispose of them in a 
collection or recycle box in accordance with 
local laws.

❏ Do not incinerate or dispose of the battery 
in fire.

For European users:

Do not dispose of batteries as ordinary refuse. Instead, 
dispose of them in a recycle box in accordance with 
local laws.

For users in the United States and Canada:

This mark indicates that the battery 
will be recycled by RBRC. When 
you dispose of the battery, contact 
RBRC.
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When handling photo cartridges

Observe the following when handling photo cartridges:

❏ Do not shake photo cartridge after removing it 
from the bag; this can cause leakage.

❏ Do not remove or tear the label on the cartridge; 
this can cause leakage.

❏ Do not use a photo cartridge beyond the date 
printed on the cartridge carton: otherwise, it may 
result in reduced print quality. For best results, use 
up the photo cartridge within six months of 
installing it.

❏ Do not dismantle photo cartridges or try to refill 
them. This could damage the print head.

❏ After bringing a photo cartridge inside from a cold 
storage site, allow it to warm up at room 
temperature for at least three hours before using 
it.

❏ Store photo cartridges in a cool, dark place.

❏ The IC chip on the photo cartridge retains a variety 
of cartridge-related information, such as the photo 
cartridge status so that the cartridge may be 
removed and reinstalled freely. However, each 
time the cartridge is inserted, some ink is 
consumed because the printer automatically 
performs a reliability check.

❏ Store each photo cartridge so that the bottom of 
its packaging faces down.
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Warnings, Cautions, and Notes

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your 
equipment.

Notes
contain important information and useful tips on the 
operation of your printer.
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Welcome!

PictureMate™ is your easy-to-use, personal photo lab. 
Just insert a digital camera memory card and you are 
ready to print brilliant photos. Because PictureMate is 
light and portable, you can print whenever and 
wherever you take photos.

A Quick Introduction to the Digital 
Photography Process

1. Take Photos 
Take photos with your digital 
camera.

2. Print
Insert your camera’s memory 
card in PictureMate, or connect 
via PictBridge, choose your 
photos, and print.

3. Save
To preserve your digital photo 
files, save them to a CD, flash 
drive, or to your computer. Then 
you can reprint them any time.

4. Clear the Memory Card
After you save your photo files, delete them from your 
memory card so you have room for more photos.

Special features

Printing with your PictureMate becomes even easier 
with these special features:

From the PictureMate LCD screen, 
you can print all your photos or you 
can select just the ones you want. 
See “Basic Photo Printing” on page 
23.

LCD screen
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If your camera supports DPOF 
(Digital Print Order Format), you 
can preselect which photos to print 
while the memory card is still in your 
camera. Then, when you insert the 
card into PictureMate, it knows 
which photos you chose. See 
“Printing Camera-Selected DPOF 
Photos” on page 30. 

If you have a PictBridge®- or USB 
DP (USB Direct Print)-enabled 
camera, you can connect the 
camera to PictureMate and control 
printing right from your camera. 
See “Printing From a 
PictBridge-Enabled Camera” on 
page 43.

If you have a Bluetooth®-enabled 
PDA, mobile phone, or computer, 
you can send photos wirelessly to 
PictureMate for printing. You just 
need the optional EPSON® 
Bluetooth Photo Print Adapter. See 
“Printing From a Bluetooth Device” 
on page 45.

If you want to print in other places 
without convenient electrical 
outlets, you can buy the optional 
PictureMate battery. See “Lithium 
Ion Battery” on page 75.

Note:
❏ PictureMate supports P.I.M. (PRINT Image 

Matching™) image enhancement standard that is 
built into many cameras. To see if your camera is 
P.I.M.-enabled, see your camera's 
documentation. 

DPOF
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Supported Photo Formats

Make sure your photos meet these requirements for 
printing with your PictureMate: 

❏ JPEG files or uncompressed TIFF files only

❏ Resolutions ranging from 80 × 80 to 9200 × 9200 
pixels 

PictureMate recognizes and prints the first 999 photos 
on your memory card. 

Where to Find Information

Unpacking and setting up

See the Start Here to set up your 
PictureMate and install the 
software. 

Using PictureMate away from home

When taking your PictureMate out 
with you, bring along the Portable 
Quick Guide for simple instructions 
on printing and problem solving.

Printing and changing settings

User's Guide - for use without a 
computer - (this book) explains how 
to print photos directly from your 
camera’s memory card. It also 
covers how to print from other 
devices, replace the PictureMate 
Photo Cartridge, take care of 
PictureMate, and troubleshoot 
problems.

JPEG TIFF
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Using your PictureMate with a computer

The on-screen User's Guide on the 
CD provides comprehensive 
information and instructions for 
using PictureMate with a computer. 

Panel Setting Menu List

Select menu

For details, see “Basic Photo Printing” on page 23.

Paper/Layout menu

For details, see “Making Paper and Print Layout 
Settings” on page 31.

Select All Select all of the photos on your card.

Select By Date Select photos by the date they were taken.

Select Range Select a sequence of photos, for example 3 
through 8.

Slideshow View all photos in sequence like a slide 
show.

Select Source Select the source of the photos when two 
or more sources are available.

10 × 15 cm (4 × 6 in.) Borderless, Border, 2 Per Print, 4 Per Print, 
ID, Half Page, Index (20-up), CD Index, 
Digital Size

16:9 wide size Borderless, Border, Greeting Card

Photo Sticker 1 Photo, 4 Photos. 9 Photos, 16 Photos
Welcome! 13



Edit menu Frame menu

Save Photo(s) menu

Maintenance menu

Crop Photo Crop a part of your photo. (& page 36)

Color Effect Select Black & White to print your photo in 
black and white. Select Sepia to print your 
photo in sepia. Select None for no effect.

Fix Photos Select Auto Correction and choose more 
detailed enhancement option or change the 
Brightness, Saturation, or Sharpness level 
manually. (& page 33)

Red-Eye Reduction Select On to correct red-eyes in your photo.
(& page 37)

Decorate Photo You can add, edit, or remove decoration 
such as pop-up on/from your photos .
(& page 35)

Rotate Rotate your photos by 90 degrees. 
(& page 37)

Add or delete P.I.F. Frames to or from your photo. You can also update 
the P.I.F. Frames in PictureMate’s internal memory  (& page 38) 

Save all or some of the photos on a memory card to an external device.

Nozzle Check

Auto Cleaning

Head Alignment

Check Photo Cartridge Status

Cleaning Sheet
14 Welcome!



Setup menu

Date Stamp Print the date your photo was taken.

Borderless Expansion Adjust the margins that are trimmed when 
you select Borderless.

MAX: No margins are printed.

MID: The expansion rate is low. (The 
margins might be printed.)

MIN: The expansion rate is lower than MID. 
(The margins might be printed.)

Bluetooth Make the Bluetooth settings. (& page 47)

Direct Print Settings If you print from a PictBridge- or USB 
DP-enabled digital camera, make the basic 
settings with this function before printing. 
(& page 43)

After Printing Decide whether to keep the print settings 
you selected or return the settings to the 
default you selected. (& page 50)

Language Select the language to display.

Personal Settings Change the PictureMate’s default settings 
to your own personal preferences. 
(& page 51)

Photo View Mode Select the default number to display from: 
15 photos, 6 photos, 1 photo (with 
guide), 1 photo (no guide). (& page 23)

Sticker Adjustment Adjust the printing position for pre-cut 16-up 
Photo Stickers.

Restore default 
settings?

Reset to the default settings. (& page 52)

Operation Sound Set PictureMate to sound a tone. 
(& page 50)

Help Display guidance for each settings.
Welcome! 15



Preparing to Print

Before you can print, you need to load paper and insert 
your memory card in PictureMate. 

Loading Paper

When loading special paper distributed by Epson, read 
the instruction sheets packed with the paper first.

Follow these steps to load PictureMate Photo Paper:

c
Caution:
Do not load plain paper; this may damage 
PictureMate. 

1. Move the handle to the back. Then open the top 
cover.

Handle

Top cover
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2. Raise and adjust the LCD screen so that you can 
see it well.

3. Press the Open button to open the front cover. 

4. Slide the edge guides to the sides.

5. Place your paper in the center, with the glossy side 
up.

Note:
Make sure paper is glossy side up to prevent 
smearing.

6. Slide the edge guides against the paper. Make 
sure they are snug, but not so tight that paper 
cannot move. 

Edge guides

Glossy side
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Note:
When you need more paper, order a PictureMate 
PicturePack. See “Ink, Paper, and Options” on page 
74 for more information. 

Paper Handling Instructions

When storing printouts

❏ Do not touch the printed side or stack your 
printouts until the ink is dry.

❏ To avoid scratching the image, be sure not to rub 
the printed side of the paper. If the printed side is 
rubbed too strongly, ink may come off the paper.

❏ Do not stack printouts with the image sides 
touching.

❏ Do not stack printouts and conventional film 
photographs with the image sides touching.

❏ If you stack printouts, place a sheet of plain paper 
or other absorbent paper between the individual 
prints.

When storing unused paper

Return any unused paper to the original package, and 
store it away from extreme temperatures, high 
humidity, and bright lights.

Media Type Loading Capacities

PictureMate Photo Paper

Epson Ultra Glossy Photo Paper 
10 × 15 cm (4 × 6 in.)

Epson Premium Glossy Photo Paper 
10 × 15 cm (4 × 6 in.)

Epson Glossy Photo Paper 10 × 15 cm 
(4 × 6 in.)

Epson Premium Semigloss Photo Paper 
10 × 15 cm (4 × 6 in.)

20 sheets

photo paper 16:9 wide size 20 sheets

Epson Photo Stickers 100 × 148 mm

Epson Photo Stickers 16 100 × 148 mm

1 sheet
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When displaying printouts

❏ When displaying your printouts indoors, Epson 
recommends placing your printouts in glass 
frames to preserve the colors in your image.

❏ Avoid displaying your printouts outdoors or in a 
place exposed to direct sunlight to prevent fading.

 Note:
For best results, allow your prints to dry thoroughly for 
24 hours before framing.

Choosing a Photo Source

If more than one source such as a memory card or 
external device are available, you need to set the 
source of the photos by following this  procedure 
before you start printing photos.

1. Press the Menu button.

2. Press the d button to highlight the Select menu, 
then press the right soft key.

3. Press the d button to highlight Select Source 
then press the right soft key.

4. Press the d button to choose from Memory Card 
or External Device, then press the right soft key.
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Inserting a Memory Card

1. Press the d On button to turn on PictureMate. 

2. Make sure the memory card light is off and no 
cards are in both slots. Then insert a memory card 
into the correct slot, as shown in the illustration. 

c
Caution:
❏ Insert just one card at a time.

❏ Load your memory card only as shown 
in the following table or you may 
damage your printer, memory card, or 
both. If you insert a card incorrectly, 
you see an error message on the LCD 
screen. Remove the memory card and 
insert it correctly.

❏ Do not press the button on the right 
side of the lower card slot when you 
insert a CompactFlash card or you 
cannot remove the card.

❏ If the CompactFlash card is not 
recognized, remove the card and 
insert it again.
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Upper slot

Memory 
card light 
turns on

Memory Stick
MagicGate Memory Stick
Memory Stick PRO

miniSDHC card *
miniSD card *

xD-Picture Card
xD-Picture Card Type M
xD-Picture Card Type H

SDHC Memory Card
SD Memory Card
MultiMediaCard

Memory Stick Duo *
Memory Stick PRO Duo *
MagicGate Memory Stick Duo *

 * Adapter required

microSDHC card *
microSD card *

Lower slot

Memory 
card light 
turns on

Microdrive

CompactFlash
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3. The memory card light flashes and then stays on. 
It takes a few seconds to recognize the memory 
card. Now you can choose photos and layouts for 
printing from the LCD screen. See “Basic Photo 
Printing” on page 23.

For the latest information on memory cards available 
for your printer, contact your dealer or regional Epson 
sales office.

Removing the memory card

When you are ready to remove a memory card, make 
sure the memory card light is not flashing, then remove 
the memory card from the slot. 

c
Caution:
Do not remove a card while the memory card 
light is flashing; you may lose photos on your 
card.

Upper slot

Lower slot

Push in the memory card. Pull the memory card out.

Press the button on the 
right twice.

Pull the memory card out.
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Basic Photo Printing

Changing the View of Photos on the LCD 
Screen

You can change the view of photos displayed by 
pressing the  Display button, and you can also set 
the default display by using the Setup menu - Photo 
View Mode setting.

Printing All Photos

1. Press the Menu button.

2. Press the d button to highlight the Select menu, 
then press the right soft key.

3. Press the d button to highlight Select All, then 
press the right soft key.

View 15 photos.

View 6 photos.

View 1 photo with operation guides for the 
photo. The print settings set for the photo are 
shown as icons on the right side.

View 1 photo at maximum size. The print 
settings set for the photo are shown as icons 
on the right side.
Basic Photo Printing 23



4. Press the OK button to increase the number of 
copies for all photos, then press the right soft key 
to set the copies.

Note:
If you want to set the number of copies for 
specified photos only, set the copies for all first, 
then select the photo you want to increase and 
press the OK button until you see the desired 
number of copies. To decrease the number of 
copies, press the left soft key.

5. To make optional settings, see “Printing Options” 
on page 31.

6. Press the right soft key to preview the print 
settings.

7. Press the right soft key to open the Paper/Layout 
menu.

8. Press the d button to highlight the desired paper 
size, then press the right soft key.

9. Press the d button to highlight the desired layout, 
then press the right soft key.

10. Press the z Print button to start printing.

Note:
If there is DPOF information on the memory card, 
PictureMate goes to DPOF print mode. See “Printing 
Camera-Selected DPOF Photos” on page 30 for 
details. To print all of the photos on the memory card, 
press the Cancel button and follow the steps above.

Printing Selected Photos

1. Press the u, d, l, or r button to highlight the 
photo you want to print, then press the OK button. 
The copy number for that photo is set to 1.

2. If you want to increase the number of copies, 
press the OK button until you see the desired 
number. To decrease the number of copies, press 
the left soft key.

3. Repeat the steps 1 and 2 for additional photos.

4. To make optional settings, see “Printing Options” 
on page 31.
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5. Press the right soft key to preview the print 
settings.

6. Press the right soft key to open the Paper/Layout 
menu.

7. Press the d button to highlight the desired paper 
size, then press the right soft key.

8. Press the d button to highlight the desired layout, 
then press the right soft key.

9. Press the z Print button to start printing.

Printing a Range of Photos 

Follow the steps below to print a range or sequence of 
photos.

1. Press the Menu button.

2. Press the d button to highlight the Select menu, 
then press the right soft key.

3. Press the d button to highlight Select Range, 
then press right soft key.

4. Press the u, d, l, or r button to highlight the first 
photo, then press the right soft key.

5. Press the u, d, l, or r button to highlight the last 
photo, then press the right soft key.
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6. Press the OK button to increase the number of 
copies for all photos, then press the right soft key 
to set the copies.

Note: 
If you want to set the number of copies for 
specified photos only, select the photo you want 
to increase and press the OK button until you see 
the desired number of copies. To decrease the 
number of copies, press the left soft key.

7. To make the optional settings, see “Printing 
Options” on page 31.

8. Press the right soft key to preview the print 
settings.

9. Press the right soft key to open the Paper/Layout 
menu.

10. Press the d button to highlight the desired paper 
size, then press the right soft key.

11. Press the d button to highlight the desired layout, 
then press the right soft key.

12. Press the z Print button to start printing.

Printing Photos Searching By Date

If you know the date the photos were taken, you can 
find and print them easily using this menu.

1. Press the Menu button.

2. Press the d button to highlight the Select menu, 
then press the right soft key.

3. Press the d button to highlight Select By Date, 
then press right soft key.

4. Highlight the date you want, then press the OK 
button to check the date.

5. Press the right soft key. Photos taken on the 
specified date are displayed.
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You can change the way the date is displayed by 
pressing the  Display button.

6. Press the u, d, l, or r button to highlight the 
photo you want to print, then press the OK button.

7. If you want to increase the number of copies, 
press the OK button until you see the desired 
number. To decrease the number of copies, press 
the left soft key.

8. To make optional settings, see “Printing Options” 
on page 31.

9. Press the right soft key to preview the print 
settings.

10. Press the right soft key to open the Paper/Layout 
menu.

11. Press the d button to highlight the desired paper 
size, then press the right soft key.

12. Press the d button to highlight the desired layout, 
then press the right soft key.

13. Press the z Print button to start printing.

Printing an Index

Prints all of the photos on your memory card or from 
the specified external device. The photo number is 
printed at the lower left and the date or file name is 
printed at the lower right of each photo.

1. Select the photos to print.

2. Press the Menu button.

3. Press the d button to highlight the Paper/Layout 
menu, then press the right soft key.

4. Press the d button to highlight 10 × 15 cm (4 × 6 
in), then press the right soft key.

5. Press the d button to highlight Index (20-up), 
then press the right soft key.

Date view Calendar view
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6. Press the z Print button to start printing.

Printing on Photo Stickers

You can print 1, 4, 9, or 16 photos on the Epson Photo 
Sticker.

1. Load an Epson Photo Sticker sheet with Loading 
Support Sheets. 

Note: 
Be sure to use the loading support sheets, and 
load one sheet at a time.

2. Press the Menu button.

3. Press the d button to highlight the Paper/Layout 
menu, then press the right soft key.

4. Press the d button to highlight Photo Sticker and 
press the right soft key.

5. Press the d button to choose 1 Photo, 4 Photos, 
9 Photos, or 16 Photos, then press the right soft 
key.

Print layout

1 photo 4 photos

9 photos 16 photos

Photo Sticker

Loading Support Sheet A

Loading Support Sheet B
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6. Press the l, u, r, or d button to select the photo 
you want to print, then press the OK button.

7. Press the OK button to increase the number of 
copies for that photo. To decrease the number of 
copies, press the left soft key.

8. Repeat steps 6 and 7 for additional photos.

9. Press the right soft key to preview the print 
settings.

10. Press the z Print button to start printing.

When using pre-cut Photo Stickers

If you are printing on pre-cut 16-up Photo Stickers, and 
the printing is misaligned, follow the steps below to 
adjust the print position.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Press the d button to highlight Sticker 
Adjustment, then press the right soft key.

4. Press the u or d button to move the print position 
in a vertical direction. Press the l or r button to 
move the print position in a horizontal direction.

You can move the print position up to 2.5 mm in 
each direction.

5. Press the right soft key to preview the print 
settings.

6. Press the z Print button to start printing.

Print layout when 4 photos, 9 photos, or 16 photos is selected 
(The images below show the case of 16 photos)

When 1 photo is selected

More than two photos or 
copies are selected
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Note:
The printer remembers the print adjustment 
setting even after it has been turned off, so you do 
not need to adjust the position each time.

Printing Camera-Selected DPOF Photos

If your camera supports DPOF (Digital Print Order 
Format), you can use it to preselect which photos and 
how many copies you want to print. See your camera’s 
manual to choose photos for printing with DPOF, then 
insert your memory card in PictureMate. PictureMate 
automatically reads your preselected photos.

1. Load paper and a memory card that contains 
DPOF data. The screen below appears on the 
LCD screen.

2. Press the right soft key to start printing.

Note:
If you want to print all of the photos on the memory 
card, press the Cancel button. See “Printing All 
Photos” on page 20.
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Printing Options

Making Paper and Print Layout Settings

You can select the print layout from the following 
options.

10 × 15 cm (4 × 6 in)

Borderless

Border

2 Per Print

4 Per Print

ID

Prints 4 35 × 45 mm photos and 5 25.4 × 38 mm photos.

Half Page

Index (20-up)

CD Index

Prints 56 photos as thumbnails

Digital Size

16:9 wide size

Borderless

Border

Greeting Card

10 × 15 cm (4 × 6 in)
Printing Options 31



1. Set the number of copies for the selected photos, 
then press the Menu button.

2. Press the d button to highlight the Paper/Layout 
menu, then press the right soft key.

3. Press the d button to highlight the desired size, 
then press the right soft key. The layout menu is 
displayed.

4. Press the d button to highlight the desired print 
layout, then press the right soft key. The selected 
paper size and layout are displayed in the upper 
left corner of the LCD screen.

Photo Sticker

1 Photo

4 Photos

9 Photos

16 Photos
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Touching Up Your Photos (Manual/Auto)

PictureMate lets you correct the color and improve the 
image quality of your photos without using a computer. 
Two basic types of adjustments are available: 

❏ Automatic adjustments 

If your camera supports PRINT Image Matching 
or Exif Print, you can use the printer's P.I.M. or 
Exif Print setting to automatically adjust your 
photos for the best results.

If your camera does not support them, you can 
use Auto Correction to make adjustments for the 
type of environment in which your photos were 
taken.

❏ Manual adjustments 

If your photos are too light or too dark, you can 
adjust their brightness or control the saturation 
and sharpness. 

Note:
These settings affect only your printed photos. They 
do not change your original image files.

These settings are saved when you turn off the printer 
or choose a different set of photos, so remember to 
turn off the settings when you are done.

Automatically adjusting your photos

When you use the printer’s automatic image 
adjustments, the adjustments are applied to all your 
photos.

1. Press the Menu button.

2. Press the d button to highlight the Edit menu, then 
press the right soft key.

3. Press the d button to highlight Fix Photos, then 
press the right soft key.

4. Press the d button to highlight Auto Correction, 
then press the right soft key.

5. Press the d button to select one of the following 
options, then press the right soft key.

❏ PhotoEnhance - Use this if a print does not 
look good; for example, this may correct 
images that are too dark, too bright, or backlit.
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❏ P.I.M. - Process images according to the 
PRINT Image Matching information in your 
digital files. This information helps to ensure 
an accurate image reproduction.

❏ Off - Prints photos as is or bypasses P.I.M. or 
Exif Print data (default setting for files with no 
P.I.M or Exif Print data).

To make manual adjustments in addition to the 
automatic ones, follow the steps in the next section.

Manually adjusting your photos

1. Press the Menu button.

2. Press the d button to highlight the Edit menu, then 
press the right soft key.

3. Press the d button to highlight Fix Photos, then 
press the right soft key.

4. Press the d button to highlight Brightness, 
Sharpness, or Saturation then press the right soft 
key.

5. Adjust other settings as necessary, then press the 
right soft key.

6. Choose the photo you want to apply this setting 
to, then press the right soft key.

Adding the Date

You can add the date your photo was originally taken 
to the bottom right corner of your print.

This function is not available for some print layouts.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Make sure Date Stamp is highlighted, then press 
the right soft key.

4. Press the d button to highlight On, then press the 
right soft key.

❏ Off (default, turns off the date stamp) 

❏ On (date, month, year: 01.Aug.2006)
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Note:
If the language is not set as English, the date 
stamp is as follows:

❏ On (year, month, date: 2006.08.01)

5. See “Basic Photo Printing” on page 23 and print 
your photos.

Decorating Your Photo

You can decorate your photos by adding clip art from 
PictureMate’s memory. You can add up to four pieces 
of clip art to a photo.

1. Highlight the photo you want to decorate.

2. Press the Menu button.

3. Press the d button to highlight the Edit menu, then 
press the right soft key.

4. Press the d button to highlight Decorate Photo, 
then press the right soft key.

5. Highlight Add Decoration, then press the right 
soft key.

6. Highlight the clip art you want to add, then press 
the OK button.

7. To move the clip art, use the 4-way scroll buttons. 
To resize the clip art, first press the right soft key 
and then use both of the soft keys. 
Printing Options 35



8. Press the OK button to set the position. If you add 
more clip art, press the right soft key and repeat 
the steps 6 to 8.

9. Press the OK button to complete adding clip art.

Cropping and Sizing Your Photos

You can print just part of a photo, cropping out the area 
that you do not want. You can choose only one photo 
to crop at a time.

1. Highlight the photo you want to crop.

2. Press the Menu button.

3. Press the d button to highlight the Edit menu, then 
press the right soft key.

4. Make sure Crop Photo is highlighted, then press 
the right soft key.

5. Use the right soft key to crop a photo. Your see a 
blue frame around the cropped area.

6. Use the following buttons to set the area you want 
to crop.

❏ Press the right or left soft key to change the 
frame size.

❏ Press the u, d, l, or r button to move the 
frame. 

❏ Press the  Display button to rotate the 
frame.

7. Press the OK button to confirm the cropped 
image.
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Removing Red-eye

When you take photos of people, they sometimes 
appear to have red-eyes in the photo. You can apply 
Red-Eye Reduction to help eliminate this problem.

1. Highlight the photo from which you want to remove 
red-eye.

2. Press the Menu button.

3. Press the d button to highlight the Edit menu, then 
press the right soft key.

4. Press the d button to highlight Red-Eye 
Reduction, then press the right soft key.

5. Press the d button to highlight On, then press the 
right soft key.

6. Choose the photo you want to apply this setting 
to, then press the right soft key.

Note:
Depending on the type of photo, parts of the image 
other than the eyes may be corrected.

Rotating a Photo on the LCD Screen

You can rotate photos in the photo frame by 90 
degrees.

Note:
This function rotates the photo image displayed on the 
LCD screen. It does not affect the printed photos.

1. Highlight the photo you want to rotate.

2. Press the Menu button.

3. Press the d button to highlight the Edit menu, then 
press the right soft key.

4. Press the d button to highlight Rotate, then press 
the right soft key.

5. Press the d button to highlight 90 degrees, 180 
degrees, 270 degrees, or Do Not Rotate then 
press the right soft key.
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Printing with P.I.F. Frames

You can decorate your photo by printing it with a P.I.F. 
Frame! With this option, the photo is printed 
borderless. You can choose P.I.F. Frames in the 
printer or in other devices and print them with photos. 
You can copy P.I.F. Frames from your PC to a memory 
card by using EPSON PRINT Image Framer Tool 
software contained in the software CD-ROM. For 
details on using the software, see the on-screen User’s 
Guide.

1. If you want to use P.I.F. Frames other than in 
PictureMate within itself, prepare the media 
containing digital photo data and P.I.F. Frames 
and connect it.

Note:
❏ You can combine photo and P.I.F. Frames in 

the same device or within the PictureMate 
itself.

❏ Be sure to save the P.I.F. Frame to the 
memory card using the EPSON PRINT Image 
Framer Tool; otherwise the P.I.F. Frame file 
name does not appear on the LCD panel.

2. Highlight the photo you want to print with a P.I.F. 
Frame.

3. Press the Menu button.

4. Press the d button to highlight the Frame menu, 
then press the right soft key.

5. Press the d button to highlight Add Frame to 
Photo, then press the right soft key. P.I.F. Frames 
that are available in PictureMate and in the device 
where the photo data is stored are displayed.

6. Press the u, d, l, or r button to highlight the P.I.F. 
Frame you want to use, then press the OK button.
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Note:
The paper sizes you can use to print with the 
selected P.I.F. Frame appear in the upper left of 
the screen.

7. Choose the photo you want to apply this setting 
to, then press the right soft key.

8. Press the OK button to increase the number of 
copies. To decrease the number of copies, press 
the left soft key.

9. Repeat the steps from 2 to 8 for additional photos.

10. Press the right soft key to preview the print 
settings.

11. Press the right soft key to open the Paper/Layout 
menu.

12. Press the d button to highlight the desired paper 
size, then press the right soft key.

13. Press the d button to highlight the desired layout, 
then press the right soft key.

14. Press the z Print button to start printing.

Updating P.I.F. Frame in PictureMate

PictureMate stores P.I.F. Frame data within itself. You 
can copy the P.I.F. Frames in the following devices 
and update the P.I.F. Frames in PictureMate’s internal 
memory.

❏ Memory card

❏ External device

Follow the steps below to update the P.I.F. Frame in 
PictureMate.

1. Connect or insert the device that contains P.I.F. 
Frame for updating.
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2. Press the Menu button.

3. Press the d button to highlight the Frame menu, 
then press the right soft key.

4. Press the d button to highlight Update Frames, 
then press the right soft key. 

5. If a confirmation message is displayed telling you 
that PictureMate will clear the print settings, press 
the right soft key to select Yes.

6. Press the d button to select the source to update 
the P.I.F. Frame, then press the right soft key.

c
Caution:
Do not connect or disconnect a memory 
card or an external device, and do not 
move PictureMate while updating P.I.F. 
Frame.

7. The P.I.F. Frame list is displayed. Select the P.I.F. 
Frames to update. The current data volume for the 
allocated space for P.I.F. Frames is shown on the 
right. P.I.F. Frame data that exceeds 100% is not 
updated.

Note: 
P.I.F. Frames stored in PictureMate’s internal 
memory are checked. P.I.F. Frames read from the 
connected device are not checked. 
You can select or deselect the P.I.F. Frames to 
store in the internal memory by using the OK 
button.

8. Press the right soft key to update.
40 Printing Options



Printing From an External Device

PictureMate can print stored photos on a computer or 
on another device such as an external hard drive, a 
Bluetooth-enabled device, or a digital camera.

Printing From an External Drive

If you saved your photos to a CD, Zip disk, or flash 
memory (thumb) drive, you can connect to the drive to 
the back of PictureMate and print just like you do when 
you insert a memory card.

You can also print photos from a CD that you get from 
a photo processing lab. (Images should be in JPEG 
file format. Some CDs may not work.)

1. Make sure PictureMate is on.

2. Make sure there are no memory cards in 
PictureMate’s memory card slots. The card light 
should be off.

Note:
If a memory card is inserted, the printer will read 
photos from the card, not from an external drive.

3. If PictureMate is connected to a computer, 
disconnect it or turn off the computer.
Printing From an External Device 41



4. Connect your CD or Zip drive’s USB cable, or plug 
your flash memory drive into the EXT. I/F port on 
the back of PictureMate.

5. For a CD or Zip drive, insert a CD or Zip disk with 
photos into the drive.

If you used PictureMate to save photos on the 
same CD-R, Zip disk, or flash memory drive more 
than once, it will have multiple folder. You see this 
message:

Press d to highlight the folder where your photos 
are stored, then press the right soft key. The most 
recently saved folder has the largest number.

6. PictureMate counts the photo on your drive, then 
shows the following screen:
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If you see this screen, you are ready to choose 
and print photos. See “Basic Photo Printing” on 
page 23 and print your photos.

Printing From a PictBridge-Enabled 
Camera

You can connect your PictBridge- or USB DP-enabled 
digital camera to the back of PictureMate and use the 
camera to control printing. (See your digital camera's 
documentation to see if it supports the PictBridge 
standard or USB DP.) 

1. Make sure PictureMate is on.

2. Make sure there are no memory cards in 
PictureMate’s slots. The memory card light should 
be off.

Note:
If a memory card is inserted, the printer will read 
photos from the card, not from a camera.

3. Press the Menu button.

4. Press the d button to highlight the Setup menu, 
then press the right soft key.

5. Press the d button to highlight Direct Print 
Settings, then press the right soft key.
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6. Follow the on-screen instructions to make the 
Direct Print Settings.

7. Connect your camera’s USB cable to your camera 
and the EXT. I/F port on the back of PictureMate.

8. Use the digital camera to select the photo you 
want to print. Be sure to make the desired print 
settings on the digital camera because the digital 
camera settings generally take precedence over 
the print settings of PictureMate. See your digital 
camera's documentation for information on more 
detailed settings.

9. Print from the digital camera.
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Printing From a Bluetooth Device

About the Bluetooth Photo Print Adapter

The optional Bluetooth Photo Print Adapter is a 
wireless communication module used to print from 
digital cameras and other devices with Bluetooth 
wireless technology without cables when connected to 
the printer.

Note:
❏ While this product complies with the Bluetooth 

Specification, it is not guaranteed to work with all 
devices enabled with Bluetooth wireless 
technology.

❏ The communication range of this product is 
approximately 10 meters; however, this may vary 
depending on conditions including obstacles 
between devices; signal quality; magnetic fields; 
static electricity and electromagnetic interference; 
software; operating system; reception sensitivity; 
and antenna performance.

Available Profile

Basic Printing Profile (BPP)

Basic Imaging Profile (BIP)
Printable file size is up to 2.5 MB. Up to 10 jobs can 
be queued (Maximum 3 MB).

Hardcopy Cable Replacement Profile (HCRP)

Object Push Profile (OPP)
Up to 10 m
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Connecting and disconnecting the 
Bluetooth Photo Print Adapter

Connecting

1. Insert the Adapter connector into the EXT. I/F port 
as shown below.

c
Caution:
Do not connect this product while the 
printer is operating. Doing so may cause 
the printer to malfunction.

2. The Adapter’s light comes on for one second. If 
the LED does not turn on, disconnect the Adapter 
from PictureMate, then reconnect it.

Disconnecting

Remove the Adapter’s connector from the EXT. I/F 
port as shown below.

c
Caution:
❏ Do not remove this product while 

communicating with another device. 

❏ Do not disconnect this product while the 
printer is operating. Doing so may cause 
the printer to malfunction.

❏ Do not remove this product by pulling on its 
upper section. Doing so may damage the 
product.
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Bluetooth settings

Use the LCD screen on PictureMate to make settings 
for Bluetooth wireless communication.
& See “Making settings” on page 48

Outline of settings

Setting Choices Description

Bluetooth Device 
Name

printer 
name-(number) 
(Default = 1)

If multiple printers 
enabled with Bluetooth 
are in the same 
communication range, 
distinguish them by 
assigning each number 
from 0 through 9.

To make the Device 
Name setting take effect, 
turn the printer off and 
then back on.

Bluetooth 
Communication 
Mode

Discoverable This mode allows devices 
enabled with Bluetooth to 
freely discover the printer 
and print.

Not Discoverable This mode prevents 
unknown devices from 
discovering the printer.

To print in this mode, first 
search for the printer 
once in Discoverable 
mode. After your device 
has discovered the 
printer in Discoverable 
mode once, it will 
subsequently be able to 
communicate with and 
print from it in this mode.

Pairing This mode requires that 
the four-digit Passkey be 
entered into a device 
before it can 
communicate with and 
print from the printer.

Bluetooth 
Encryption

On/Off
(Default = Off)

Select On to encrypt 
communication. 
Encryption requires that 
the four-digit Passkey be 
entered into a device 
before it can 
communicate with and 
print from the printer.
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Making settings

1. Connect the Bluetooth Photo Print Adapter to 
PictureMate.
& See “Connecting and disconnecting the 
Bluetooth Photo Print Adapter” on page 46

c
Caution:
Be sure that the printer is not operating 
before connecting this product. Otherwise, 
the printer may malfunction.

2. Press the Menu button. 

3. Press the d button to highlight the Setup menu, 
then press the right soft key.

4. Press the d button to highlight Bluetooth, then 
press the right soft key.

5. Make sure Bluetooth Settings is highlighted, then 
press the right soft key.

6. Press the right soft key to select the desired 
Bluetooth option.

7. Change the settings of each item using the u, d, 
l, or r button. See “Outline of settings” on page 
47 for information about Bluetooth settings except 
Passkey setting. See the “The Bluetooth Passkey 
Setting” on page 49 to set the Passkey.

Bluetooth Passkey 

Any four-digit 
number
(Default = 0000)

The Passkey setting 
allows you to set the 
four-digit Passkey that 
must be entered into a 
device before printing if 
Pairing is selected as the 
BT Comm Mode or if 
Encryption is On.

Bluetooth Device 
Address

Set at the factory 
(Example)
11-11-11-11-11-11

Displays the unique 
Bluetooth Device 
Address of the printer.
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The Bluetooth Passkey Setting

1. Press the u or d button to select a number for the 
digit, then press the r button to set the number.

Note:
Press the l button to return to the digit on the left.

2. Select numbers for the other digits in the same 
manner, then press the right soft key.

3. At the confirmation screen, press the right soft key 
to activate the Passkey.

Printing

1. Make sure the Bluetooth Photo Print Adapter is 
connected to PictureMate and Bluetooth settings 
have been made. For details on connecting the 
Bluetooth Photo Print Adapter, see “Connecting 
and disconnecting the Bluetooth Photo Print 
Adapter” on page 46. See “Bluetooth settings” on 
page 47 to set the Bluetooth settings.

2. Use the PictureMate’s control panel to adjust the 
print settings. (For example Paper/Layout and 
Color Effect.)

3. Print the data from your Bluetooth enabled device.

Note:
The settings available may vary among Bluetooth 
wireless-capable devices. For more information, refer 
to your device’s documentation.

For more information about printing from Bluetooth 
wireless-capable mobile phones, digital still cameras, 
digital video cameras, PDAs, mobile PCs and other 
Bluetooth wireless-capable device, refer to the 
documentation for both the device and the printer.
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Setting PictureMate Preferences

Set Operation Sound On or Off

Set the Operation Sound setting to On to set 
PictureMate to sound a tone, for example when an 
error or warning occurs.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Press the d button to highlight Operation Sound, 
then press the right soft key.

4. Press the d button to highlight the setting you 
want to change, then press the right soft key.

❏ Battery Status : Beeps when the battery is 
low.

❏ Error Status : Beeps when the cartridge is 
expended or the paper is out.

❏ Button : Bleeps when an invalid button is 
pressed or grayed-out unavailable item is 
selected.

5. Press the d button to highlight On, then press the 
right soft key.

Setting the After Printing Confirmation

This setting lets you decide whether to keep the print 
settings you selected or return the settings to the 
default you selected in After Printing setting. For more 
information on making your own default settings, see 
“Changing the Default Print Settings” on page 51.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Press the d button to highlight After Printing, then 
press the right soft key.
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4. Press the d button to highlight the desired 
settings, then press the right soft key.

❏ Ask Each Time : Display the confirmation 
screen after printing and let you choose 
whether to keep your settings or return to the 
default you selected.

❏ Save Settings : Keep the settings after 
printing.

❏ Clear Settings : Default. Return to the 
personal default settings.

Note:
Even when you select Save Settings or Ask Each 
Time and choose to keep the settings, they will not 
be kept in the following cases.

❏ When you select another print option.

❏ When the memory card is removed.

❏ When PictureMate in turned off.

Changing the Default Print Settings

You can change the PictureMate’s default settings to 
your own personal preferences.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Press the d button to highlight Personal Settings, 
then press the right soft key.

4. Follow the on-screen information to change the 
settings.
Setting PictureMate Preferences 51



Resetting All Print Settings

Follow the steps below to reset the print settings you 
have changed. Adjusted values for head alignment, 
Bluetooth settings, and the language setting are not 
reset.

1. Press the Menu button.

2. Press the d button to highlight the Setup menu, 
then press the right soft key.

3. Press the d button to highlight Restore default 
settings?, then press the right soft key.

4. At the confirmation screen, press the right soft key 
to reset all the print settings.
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Saving Your Photos to an External Device (Backup)

You can choose your photo files on your memory card 
and save them to one of the following devices by 
connecting the device directly to PictureMate. Except 
for the Flash memory drive, you can save photos to 
several disks when the photo data size is larger than 
the disk size:

❏ CD-R/RW drive (CD-R/DVD-R media only)

❏ MO drive

❏ Iomega® Zip® disk (100, 250, or 750 MB)

❏ Flash memory (thumb) drive

Note:
Epson cannot guarantee the compatibility of any 
drives.

1. Make sure PictureMate is on.

2. Insert your memory card into PictureMate.

3. If you are using a CD-R/RW drive or Zip drive, plug 
it into an electrical outlet if required.

4. Connect the drive to PictureMate.

❏ For a CD-R/RW, MO or Zip drive, connect its 
USB cable to the EXT. I/F port on the back of 
PictureMate. Then insert a CD-R/DVD-R, MO 
or Zip disk in the drive.
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❏ For a flash memory drive, plug it into the EXT. 
I/F port on the back of PictureMate.

Note: 
If you want to save specified photos only, select 
the photos first.

5. Press the Menu button.

6. Press the d button to highlight the Save Photo(s) 
menu, then press the right soft key.

7. Select All Photo or Selected Photos, then press 
the right soft key.

8. When the confirmation message appears, press 
the right soft key.

9. If a message asking if you want to print an index 
of the saved photo(s) is displayed, select Yes or 
No. If you select Yes, the printer starts printing 
photos to be saved in  CD Index layout after 
saving the photos to a disk. This layout prints a 
maximum of 56 thumbnails. Load 4 × 6 inch photo 
paper in the paper feeder.

10. Follow the instructions on the LCD screen to save 
photos.

Note:
You cannot cancel saving photos once it has 
started.

11. When saving has finished press the right soft key.

c
Caution
Do not remove the drive or memory card while 
the photos are being saved, or you may lose 
photos on your card or drive. You can save 
photos multiple times to the same disk or drive 
until it is full. Each time you save photos on the 
same disk or drive, they are saved in a new 
folder. The first folder is named 001, the second 
folder is named 002, and so on. If you save on 
a CD-R/DVD-R, PictureMate names the 
CD-R/DVD-R Photo.
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Replacing the Photo Cartridge

Checking the Photo Cartridge Status

When the photo cartridge is low on ink, you see this 
icon in the upper-right corner of the LCD screen.

You can check the photo cartridge status at any time.

1. Press the Menu button.

2. Press the d button to highlight the Maintenance 
menu, then press the right soft key.

3. Press the d button to highlight Check Photo 
Cartridge Status, then press the right soft key.

4. You see a screen showing the photo cartridge 
status. Press the right soft key to close the screen.

Ink low
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Replacing the Photo Cartridge

When the photo cartridge needs replacement, you see 
a message on the LCD screen.

PictureMate uses photo cartridge equipped with an IC 
chip. The IC chip monitors the photo cartridge status.

w
Warning:
Keep photo cartridges out of the reach of 
children. Do not allow children to drink from or 
handle the cartridges.

c
Caution:
❏ Epson recommends the use of genuine 

Epson photo cartridges. Epson warranties 
do not cover damage to your printer 
caused by the use of photo cartridges not 
manufactured by Epson.

❏ Leave the old cartridge installed in the 
printer until you have obtained a 
replacement; otherwise, ink remaining in 
the print head nozzles may dry out.

❏ Do not refill photo cartridges. Other 
products not manufactured by Epson may 
cause damage that is not covered by 
Epson’s warranties, and under certain 
circumstances, may cause erratic printer 
behavior.

Note:
In addition to the ink used during an image printing, ink 
is consumed during the print head cleaning operation, 
and during the self-cleaning cycle which is performed 
when the printer is turned on.

For more information about photo cartridges.
& See “When handling photo cartridges” on page 8

1. Make sure that PictureMate is on, but not printing.
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2. Open the cartridge compartment cover on the 
back of PictureMate.

3. Set the cartridge lever in the Release position by 
pulling it to the left. The photo cartridge will be 
ejected about halfway out of the cartridge holder.

4. Pull the cartridge out of PictureMate and dispose 
of it properly.

Note:
❏ Do not take the used cartridge apart or try to 

refill it. Do not shake the used photo cartridge; 
otherwise, it may leak.

❏ The photo cartridge must be replaced when 
any one of the colors is depleted. The rate that 
a specific color of ink is consumed depends 
on the images printed.

5. Remove the replacement photo cartridge from its 
package.
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c
Caution:
❏ Do not touch the green IC chip on the 

side of the cartridge. This can damage 
the photo cartridge.

❏ If you remove the photo cartridge for 
later use, be sure to protect the ink 
supply ports from dirt and dust; store it 
in the same environment as the 
printer. Note that there is a valve in the 
ink supply ports, making covers or 
plugs unnecessary, but care is needed 
to prevent the ink from staining items 
that the cartridge touches. Do not 
touch the ink supply ports or 
surrounding area.

❏ Be sure to always install a photo 
cartridge into the printer immediately 
following the removal of the current 
photo cartridge. If a photo cartridge is 
not installed promptly, the print head 
may dry out, rendering it unable to 
print.

6. Place the cartridge properly into the cartridge 
holder, then push it in until you feel resistance and 
hear the cartridge faintly click into place.

Do not touch this part.
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7. Set the lever to the Lock position by sliding it to 
the right.

8. Close the cartridge compartment cover.

Note:
If you cannot close the cartridge compartment cover, 
the photo cartridge is not installed correctly. Go back 
to the step 4 and eject the photo cartridge. Then install 
the photo cartridge again.
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Transporting Your PictureMate

PictureMate’s handle makes it easy to carry short 
distances. If your PictureMate is going to travel a 
longer distance, you should pack it carefully following 
the steps below to protect it from getting damaged. 

c
Caution:
Keep PictureMate out of the sun and don’t leave 
it in your car or other location where it can get 
too hot. 

1. If PictureMate is on, turn it off.

2. Wait until the LCD screen goes blank, then unplug 
the power cord from the electrical outlet. 

3. Remove paper from the paper feeder and front 
cover.

4. Close the LCD screen.

5. Close the top cover and front cover.

6. Disconnect the power cord and any connected 
USB cable from the back of PictureMate. 

7. Pack the power cord, AC adapter, paper, spare 
photo cartridge, and all manuals in the travel case.

8. Pack PictureMate and the travel case in the box 
that PictureMate came in. 
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c
Caution:
Make sure the photo cartridge is installed 
before transporting. Do not place 
PictureMate on its side or upside down, or 
ink may leak. 

Note:
If your prints do not look as good after PictureMate 
has been moved, try aligning the print head. See 
“Aligning the Print Head” on page 63. 
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Maintaining PictureMate

Cleaning and Checking the Print Head 
Nozzles 

If your print quality is not as good as it used to be, if 
your photos are light or faint, or you are missing colors 
in your prints, your print head nozzles may be clogged. 

Note:
❏ Print head cleaning consumes some ink. To avoid 

wasting ink, clean the print head only if print quality 
declines; for example, if the printout is blurry or the 
color is incorrect or missing.

❏ Use the Nozzle Check function first to confirm that 
the print head needs to be cleaned. This saves ink.

❏ If a message on the LCD screen tells you that the 
cartridge needs replacement or is low on ink, you 
cannot clean the print head. You must first replace 
the photo cartridge.

1. Make sure that PictureMate is turned on and no 
warnings or errors are displayed on the LCD 
screen.

2. Load a sheet of paper. See “Loading Paper” on 
page 16.

3. Press the Menu button.

4. Press the d button to highlight the Maintenance 
menu, then press the right soft key.

5. Press the d button to highlight Auto Cleaning, 
then press the right soft key.

6. If a confirmation message is displayed, press the 
right soft key to select OK. The cleaning starts. 
The processing icon appears on the screen while 
cleaning is in progress.

7. Press the right soft key, then press the z Print 
button to print the nozzle check pattern.
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8. Examine the nozzle check pattern you printed.

Below are sample printouts.

The above sample may be shown in black and white, but the actual 
test prints in color (Black, Cyan, Magenta and Yellow).

If the nozzle check page does not print satisfactorily 
(for example, if any segment of the printed lines is 
missing), your print head nozzles may be clogged.

9. If the nozzle check pattern is satisfactory, press 
the right soft key. If the nozzle check pattern is not 
satisfactory, press the left soft key and clean the 
print head again. If you do not see any 
improvement after cleaning about two times, 
check the solutions beginning on page 69. You 
can also turn the printer off and wait for at least 6 
hours - this allows any dried ink to soften-and then 
try cleaning the print head again.

Aligning the Print Head

If you have moved PictureMate and the print quality is 
not as good as it was before—for example, you see 
misaligned vertical lines or light or dark horizontal 
banding—you may need to align the print head.

1. Make sure that PictureMate is turned on and no 
warnings or errors are displayed on the LCD 
screen.

2. Load a sheet of photo paper. See “Loading Paper” 
on page 16.

3. Press the Menu button.

4. Press the d button to display the Maintenance 
menu, then press the right soft key.

5. Press the d button to highlight Head Alignment 
then press the right soft key.

Okay

Needs Cleaning
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6. Press the right soft key to proceed. 

7. Press the z Print button to print the Head 
Alignment Pattern.

8. The following Head Alignment Pattern is printed.

9. Look at the alignment pattern in each set and find 
the patch which is most evenly printed, with no 
noticeable streaks or lines.

10. Press the u or d button to highlight the number 
for the best pattern (1 to 9) in set #1, then press 
the right soft key.

11. Select the number for set #2, then press the right 
soft key.
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Cleaning PictureMate

Cleaning the roller inside

When you use Epson Ultra Glossy Photo Paper, use 
this function to clean the roller inside PictureMate.

1. Load several sheets of paper.

2. Press the Menu button.

3. Press the d button to highlight the Maintenance 
menu, then press the right soft key.

4. Press the d button to highlight Cleaning Sheet, 
then press the right soft key, then follow the 
instructions on the LCD screen.

5. Repeat Steps 2 to 4 if needed, and press the left 
soft key to exit.

Cleaning the outer case

To keep PictureMate operating at its best, clean it 
thoroughly several times a year as follows.

1. Turn off PictureMate and unplug the power cord.

2. Remove any paper from the paper feeder.

3. Use a soft brush to carefully clean away all dust 
and dirt from the paper feeder.

4. If the outer case or the inside of the paper feeder 
is dirty, wipe it with a soft, clean cloth dampened 
with mild detergent. Keep the front cover closed 
to prevent water from getting inside.

c
Caution:
❏ Never use alcohol or thinner to clean the 

printer, as these chemicals can damage 
the components as well as the case.

❏ Be careful not to get water on the printer 
mechanism or electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with 
lubricants. Unsuitable oils can damage the 
mechanism. Contact your dealer or a 
qualified service person if lubrication is 
needed.



Troubleshooting

The solutions herein are for problems when printing 
without using a computer.

Error/Warning Messages

You can diagnose and solve most problems by 
checking the error messages on the LCD screen. If 
you cannot solve the problems, by checking the 
messages, use the following table and try the 
recommended solution. 

Display Solution

A printer error has 
occurred. See your printer 
documentation.

Turn PictureMate off and then back on. 
If the error message still appears, 
contact your dealer. 

& See “Contacting Customer Support” 
on page 72

Photo cartridge low. 
Replace cartridge soon.

Press the right soft key to clear the error. 
Prepare the new photo cartridge. If you 
tried to clean the print head, replace the 
photo cartridge first.

& See “Replacing the Photo Cartridge” 
on page 56

Replace photo cartridge 
now. For best results, use 
genuine Epson photo 
cartridge.

Replace the photo cartridge with a new 
one.

& See “Replacing the Photo Cartridge” 
on page 56

Service required. Parts 
inside your printer are near 
the end of their service life. 
See your printer 
documentation. 

Contact Epson for assistance. 

&  See “Contacting Customer Support” 
on page 72

Service required. Parts in 
your printer are at the end 
of their service life. See 
your printer 
documentation.

Bluetooth adapter error. 
Re-insert adapter. 

Disconnect the Adapter, then reconnect 
to the printer.

& See “Printing From a Bluetooth 
Device” on page 45

Error in data. Printouts 
may be affected. 

The print results may not be perfect. 
Check the data.

The image is too large. 
See your printer 
documentation. 

Press the right soft key to clear the error. 
Check the data.

The image is too complex. 
See your printer 
documentation.

Display Solution
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Printer Power Problems

LCD screen is off

❏ Press the d On button to make sure that 
PictureMate is on.

❏ Turn off PictureMate and make sure that the 
power cord is securely plugged in.

❏ Make sure that your outlet works and is not 
controlled by a wall switch or timer.

LCD screen came on and then went out

The PictureMate’s voltage may not match the outlet 
rating. Turn off PictureMate and unplug it immediately. 
Then, check the printer labels.

c
Caution:
If the voltage does not match, DO NOT PLUG 
YOUR PRINTER BACK IN. Contact your 
dealer.

Cannot recognize the 
external device. See your 
printer documentation.

Disconnect the device and check that it 
meets the PictureMate specifications.

Cannot recognize the 
memory card. See your 
printer documentation.

Make sure the memory card has been 
inserted correctly. If so, check to see if 
there is a problem with the card and try 
again.

The battery is empty. Connect the AC adapter.

Battery overheating. Turn the PictureMate off, and wait until 
the battery temperature decreases.

This battery voltage is 
abnormal.

Turn the PictureMate off. Replace the 
battery with a new one.

Display Solution
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Print and Noise Problems

PictureMate makes an unexpected noise after you 
install a photo cartridge.

The first time you install the photo cartridge, 
PictureMate will charge its print head for about three 
and a half minutes. Wait until charging finishes before 
you turn it off, or it may charge improperly and use 
more ink the next time you turn it on. 

PictureMate makes an unexpected noise when you 
turn it on or after it has been sitting for awhile.

PictureMate is performing routine maintenance.

PictureMate sounds as though it is printing, but 
nothing prints.

❏ PictureMate may be preparing to print. 

❏ Make sure the print head nozzles are not clogged. 
To clean the print head, see “Cleaning and 
Checking the Print Head Nozzles” on page 62.

❏ PictureMate will not work properly if it is tilted or 
at an angle. Place it on a flat, stable surface that 
extends beyond the printer base in all directions.

❏ Make sure paper is not jammed and is loaded 
correctly so it can feed into PictureMate. Make 
sure the handle is not resting on the paper. See 
“Loading Paper” on page 16 for paper loading 
instructions.

The memory card does not work correctly.

❏ Make sure you are using a compatible memory 
card. See “Inserting a Memory Card” on page 20.

❏ Make sure only one card is inserted at a time. 
PictureMate does not read from multiple cards at 
once.

❏ Photos must be in JPEG or Uncompressed TIFF 
format and taken with a DCF-compliant camera.

❏ PictureMate can recognize and print the first 999 
photos on your memory card.
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Photo Quality Problems

You see banding (light lines) in your prints.

❏ The print head nozzles may need cleaning; see 
“Cleaning and Checking the Print Head Nozzles” 
on page 62.

❏ Make sure the glossy side of the paper is face up.

❏ The photo cartridge may need replacing. To 
replace the cartridge, see “Replacing the Photo 
Cartridge” on page 56.

❏ The print head may need aligning; see “Aligning 
the Print Head” on page 63. 

Your printout is blurry or smeared.

❏ Use only paper recommended by Epson to ensure 
proper saturation, ink absorption, and quality. See 
“Ink and Paper” on page 74.

❏ Make sure you load paper with the glossy side 
face up. 

❏ Make sure your paper is not damp or curled, or 
loaded face down (the glossy side should be face 
up). If it is damp or curled, load a new stack of 
paper.

Your printout is faint or has gaps in the image.

❏ The print head may need aligning; see “Aligning 
the Print Head” on page 63. 
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❏ The print head nozzles may need cleaning; see 
“Cleaning and Checking the Print Head Nozzles” 
on page 62 for instructions. 

❏ The photo cartridge may be old or low on ink. To 
replace the photo cartridge, see “Replacing the 
Photo Cartridge” on page 56.

❏ Make sure your paper is not damaged, old, dirty, 
or loaded face down. If it is, reload a new stack of 
paper with the glossy side up.

Colors in your photo are wrong or missing. 

❏ Make sure the Color Effect setting is set to None 
for color photos.

❏ The print head nozzles may need cleaning; see 
“Cleaning and Checking the Print Head Nozzles” 
on page 62.

❏ The photo cartridge may be old or low on ink. To 
replace the cartridge, see “Replacing the Photo 
Cartridge” on page 56. 

Problems With Paper Feeding 

Paper does not eject fully or is wrinkled. 

If it is wrinkled when it ejects, the paper may be damp 
or too thin.

Paper does not feed correctly or jams in the 
printer.

❏ Make sure the top cover is open, and is not leaning 
on the handle. The handle should be back of 
PictureMate. Make sure the handle is not resting 
on the paper. See “Loading Paper” on page 16.

❏ If paper does not feed, remove it from paper 
feeder, reload it in the center, then slide both edge 
guides against the paper (but not too tightly).

❏ If multiple pages feed at once, remove the paper 
from the paper feeder, separate the sheets, and 
carefully reload it.

❏ If paper jams, remove the paper, then press the 
OK button to clear the jam.
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❏ Load paper glossy side up. Load up to a maximum 
of 20 sheets for photo papers, or 1 sheet for Photo 
Sticker. Place the paper in the center and slide 
both edge guides against it, but not so tight that 
paper cannot move.

❏ Do not load plain paper; this may damage 
PictureMate.

❏ Make sure you are using available paper for 
PictureMate (see “Ink and Paper” on page 74). 
Store paper flat to help prevent curling. 

Miscellaneous Printout Problems 

The printer prints blank pages.

The print head may need cleaning. See “Cleaning and 
Checking the Print Head Nozzles” on page 62. 

The borders or layout are incorrect.

❏ Check your Layout setting to see if it is correct. 
See “Making Paper and Print Layout Settings” on 
page 31.

❏ If you have a border on one side of your photo but 
not the other, make sure the paper is placed in the 
center of the paper feeder. Slide the edge guides 
against the paper. 

❏ If the subject of your photo is very close to the 
edge of the image, you can change the amount of 
cropping around the edge of the image for 
Borderless printing by using Borderless 
Expansion from the Setup menu. If you see a 
white line around the edge of the print, select MID 
or MAX.

The wrong photo is printed.

❏ If your camera supports DPOF, you can preselect 
photos so PictureMate will print only the ones you 
want. See “Printing Camera-Selected DPOF 
Photos” on page 30. 

❏ If your camera is PictBridge- or USB DP-enabled, 
you can connect it to PictureMate and control 
printing from your camera. See “Printing From a 
PictBridge-Enabled Camera” on page 43.
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Contacting Customer Support

Regional Customer Services

If your Epson product is not operating properly and you 
cannot solve the problem using the troubleshooting 
information in your product documentation, contact 
customer support services for assistance. If customer 
support for your area is not listed below, contact the 
dealer where you purchased your product.

Customer support will be able to help you much more 
quickly if you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of 
the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the 
product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and 
version

❏ Names and versions of the software applications 
you normally use with your product

Note:
For more information on Contacting Customer 
Support, see the Online User's Guide included in the 
software CD-ROM.

Singapore

URL http://www.epson.com.sg

Telephone (65) 6586 3111

Thailand

URL http://www.epson.co.th

Telephone (66) 2-670-0333

Vietnam

Telephone 84-8-823-9239

Indonesia

URL http://www.epson.co.id
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Telephone/Fax Jakarta: (62) 21-62301104

Bandung: (62) 22-7303766

Surabaya: 
(62) 31-5355035/31-5477837

Medan: (62) 61-4516173

Telephone Yogyakarta: (62) 274-565478

Makassar:
(62) 411-350147/411-350148

Hong Kong

URL http://www.epson.com.hk

Phone (852) 2827-8911

Fax (852) 2827-4383

Malaysia

URL http://www.epson.com.my

Phone 603-56288333

India

URL http://www.epson.co.in

Phone 30515000

FAX 30515005/30515078

Philippines

URL http://www.epson.com.ph

Phone (63) 2-813-6567

Fax (63) 2-813-6545

E-mail epchelpdesk@epc.epson.com.ph
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Ink, Paper, and Options

Ink and Paper

The following photo cartridge and Epson special paper 
are available for PictureMate. This information is only 
for standalone operation. 

* For update information, check the Epson support site.

Note:
❏ The availability of special paper varies by location.

❏ A6 size pre-cut 4-up and 16-up Epson Photo 
Stickers are not available.

❏ Please check your local Epson customer support 
Web site where to buy or visit your local dealer.
& See “Contacting Customer Support” on page 72

❏ If you want to use paper other than the types listed 
above, refer to the online User’s Guide manual.

PictureMate PicturePack 
(PictureMate Photo Cartridge and 150 sheets of 
PictureMate Photo Paper) 

T5852

Epson Ultra Glossy Photo Paper  10 × 15 cm 
(4 × 6 in.)

S041926

S041943

Epson Premium Glossy Photo Paper 10 × 15 cm 
(4 × 6 in.)

S041706

S041729

S041730

S041750

Epson Glossy Photo Paper 10 × 15 cm (4 × 6 in.) S042068

S042070

S042072

Epson Premium Semigloss Photo Paper 10 × 15 cm 
(4 × 6 in.)

S041925

Epson Photo Stickers 100 × 148 mm *

Epson Photo Stickers 16 100 × 148 mm *
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Options

Bluetooth Photo Print Adapter

Bluetooth Photo Print Adapter 2 C12C82438*

Note:
The asterisk is a substitute for the last digit of the 
product number, which varies by location.
& See “Printing From a Bluetooth Device” on page 45

Lithium Ion Battery

An optional rechargeable battery means you can use 
PictureMate without the AC adapter.

Lithium Ion Battery C12C83108✽, model D121A

Note:
The asterisk is a substitute for the last digit of the 
product number, which varies by location.

For details on using the optional battery, see the 
following section.

Using the Optional Battery

Note:
❏ Install the battery after installing the first photo 

cartridge and after ink charging is finished.

❏ You cannot save data on the memory card to an 
external device when using the battery. Connect 
the AC adapter to PictureMate when you save 
data.

❏ When you copy data on a computer to your 
memory card, confirm that there is enough power 
in the battery. If the battery runs out, saving is 
canceled, and corrupted data may remain on the 
memory card.

For safety instructions for the battery, see “When using 
the optional battery” on page 5.

Installing the battery

Follow the steps below to install the battery.

1. Make sure that PictureMate is turned off.

2. Unplug the AC adapter from the printer.
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3. Press the release latch and remove the battery 
cover.

4. Insert the battery into the compartment in the 
direction shown below until it is fixed in place. 

Removing the battery

1. Make sure that PictureMate is turned off.

2. Press the release latch and pull out the battery.

3. Attach the battery cover as shown below.

Charging the battery

After installing the battery, charge the battery using the 
AC adapter.

1. Make sure that the battery is installed.
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2. Connect the power cord and AC adapter, then 
plug in PictureMate.

When PictureMate is off, the power light blinks 
during charging. When the battery is fully charged, 
the power light turns off.

When PictureMate is on during charging,  icon 
blinks on the LCD screen. When the battery is fully 
charged,  icon appears.

Note:
The battery may not be charged correctly if the 
temperature of the operation is not guaranteed.

Checking the battery status

The battery status is always displayed at the top right 
corner of the LCD screen.

Battery performance

* When printing from a memory card with a fully charged, fresh battery, 
at room temperature. The number of sheets varies depending on the 
memory card, data size, and other conditions.Icon Status

Sufficient battery power

When the icon is green, battery power is low. 

When the icon is red, battery power is almost 
empty.

Battery power is running out.

Battery is charging. 

Battery is fully charged.

Charging Time Approx. 120 minutes (Approx. 150 
minutes at maximum)

Continuous Print Time Approx. 100 minutes *

Number of Prints Approx. 100 sheets (4 × 6 in.) *

Icon Status
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Auto Power Off

When the battery is used to power PictureMate, 
PictureMate will automatically turn off to save battery 
power if it is idle for about 15 minutes.

Note:
When a memory card is inserted and PictureMate is 
connected to a computer, it will not turn off 
automatically.
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Printer Specifications

Mechanical Electrical

Rating

Printer

AC Adapter

Dimensions Storage

Width: 215 mm (8.5 inches)
Depth: 152 mm (6.0 inches)
Height: 145 mm (5.7 inches)

Printing

Width: 215 mm (8.5 inches)
Depth: 339 mm (13.3 inches)
Height: 261 mm (10.3 inches)

Printable area Border printing: 3 mm margin for all sides 
of photo paper, and 17 mm margin on the 
bottom and 3 mm margin on the other 
sides for Photo Sticker

Borderless printing: 0 mm margin

Paper tray capacity Photo paper: 20 sheets

Photo Sticker: 1 sheet

Weight 2.4 kg (5.3 lb) without AC adapter and 
photo cartridge

AC adapter operated Optional battery 
operated

Input DC 20 V, 1.6 A DC 14.8 V, 1.1 A

Model A381H

Input AC 100-240 V, 50-60 Hz, 0.8-0.4 A, 42 W

Output DC 20 V, 1.68 A
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Printer Operated by AC Adapter Environmental

* Without condensation

When not charging 
optional battery

When charging 
optional battery

AC 
100-120 
V Input

AC 
220-240 
V Input

AC 
100-120 
V Input

AC 
220-240 
V Input

Power 
consumption 
using AC 
adapter

Continuous 
printing

Approx. 
19 W

Approx. 
19 W

Approx. 
34 W

Approx. 
33 W

Low power 
mode

Approx. 
4.0 W

Approx. 
4.0 W

Approx. 
24 W

Approx. 
24 W

Power off 
mode

Approx. 
0.4 W

Approx. 
0.4 W

Approx. 
25 W

Approx. 
25 W

Input current using AC 
adapter (Continuous 
printing)

0.4 A 
(MAX 
0.5 A)

0.2 A 
(MAX 
0.3 A)

0.7 A 
(MAX 
0.8 A)

0.4 A 
(MAX 
0.5 A)

Temperature Operation: 
10 to 35 °C (50 to 95 °F)

Storage: 
-20 to 60 °C (-4 to 140 °F)

1 month at 40 °C (104 °F)

Humidity Operation:*
20 to 80% RH
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Memory card slots

* Maximum capacity is 128 MB.

**  Adapter required.

Card Slots CF Type II card 
slot

Compatible with “CF+ and 
CompactFlash Specification 
1.4”

Memory Stick/
Memory Stick 
PRO card slot

Compatible with “Memory 
Stick Standard version 1.3”

Compatible with “Memory 
Stick Standard Memory Stick 
PRO Format Specifications 
version 1.0”

SD/
MMC card slot

Compatible with “SD Memory 
Card Specifications / PART1. 
Physical Layer Specification 
Version 2.00"

Compatible with 
“MultiMediaCard Standard”

xD-Picture card 
slot

Compatible with “xD-Picture 
Card™ Card Specification 
Version 1.20 Type M cards / 
Type H cards”

Compatible 
memory cards

CompactFlash 

Memory Stick*

Memory Stick PRO

Memory Stick Duo**

Memory Stick PRO Duo**

MagicGate Memory Stick*

MagicGate Memory Stick Duo**

Microdrive

SDHC Memory Card

SD Memory Card

miniSDHC card**

miniSD card**

microSDHC card**

microSD card**

MultiMediaCard

xD-Picture Card

xD-Picture Card Type M

xD-Picture Card Type H

Voltage 
Requirements

3.3 V

3.3 V/5 V Combined use

Maximum current is 500 mA
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Note:
For the latest information on memory cards available 
for your printer, contact your dealer or regional Epson 
sales office.

Photo Cartridge

PictureMate Photo Cartridge 

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

External Storage Devices

* Not all USB devices are supported. Contact your regional customer 
support for details.Color Black, Cyan, Magenta and Yellow

Cartridge life Use within 6 months of opening the package.

Temperature Storage:
-30 to 40 °C (-22 to 104 °F)

1 month at 40 °C (104 °F)

Freezing:*
-15 °C (5 °F)

Connectivity Universal Serial Bus*

Bit rate: 480 Mbps (High speed device) 

Connector type: USB Series A

Data Encoding: NRZI

Recommended cable length: Less than 1.8 meters
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Standards and Approvals

Printer

U.S. model: 

European model: 

Australian model: 

AC Adapter

U.S. model:

European model:

Australian model:

Safety UL60950-1

CSA No.60950-1

EMC FCC Part15 Subpart B Class B

CAN/CSA-CEI/IEC CISPR22 Class B

EMC EN55022 Class B

EN55024

EMC Directive 89/336/EEC

EMC AS/NZS CISPR22 Class B

Safety UL60950-1

CSA No.60950-1

EMC FCC Part15 Subpart B Class B

CAN/CSA-CEI/IEC CISPR22 Class B

Safety Low Voltage Directive 72/23/EEC

EN60950-1

EMC EMC Directive 89/336/EEC

EN55022 Class B

EN55024

EN61000-3-2

EN61000-3-3

Safety AS/NZS 60950.1

EMC AS/NZS CISPR22 Class B
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A

All photos, 23
Auto correct photo, 33

B

Battery
buying, 75
using, 75

Black and white printing, 14
Blank pages, 71
Bluetooth, 45, 75
Blurry prints, 69

C

Camera
printing from, 43
selected photos (DPOF), 30

Care of PictureMate, 62
Carrying PictureMate, 60
CD

printing from, 41
saving files to, 53

CD Index, 13
Cell phone

printing from, 45
Charging ink, 68

Cleaning
printer, 65
print head, 62

Clip art, 35
Clogged nozzles, 62
Color

problems, 70
Consumables, 74
Crop

photo, 36

D

Date Stamp, 34
Device

external, 41 to 44
DPOF (Digital Print Order Format), 30

E

Edge guide, 17
Error Messages, 66
External device, 41 to 44

F

Faint images, 69
File formats, 12
Fix photo, 33
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Flash memory drive
printing from, 41
saving files to, 53

Front cover, 17

G

Gaps in image, 69

I

Image
formats, 12
quality, 69 to 70

Incorrect colors, 70
Index sheet, 27
Ink, see Photo cartridge

J

Jams
paper, 70

JPEG, 12

L

LCD screen
messages, 66

M

Maintenance, 62
Manuals, 12
Margins

incorrect, 71
Memory card

compatibility, 81
inserting, 20
problems, 66, 68
removing, 22

Memory Stick, 20
Microdrive, 20
Missing colors, 70
MMC (MultiMediaCard), 20

N

Noise
PictureMate, 68

Nozzle check, 62
Nozzle cleaning, 62

O

On button, 20
Options, 74

P

Packing PictureMate, 60
Paper

buying types, 74
feeding problems, 70 to 71
jam, 70

PDA
printing from, 45

Photo
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formats, 12
quality, 69 to 70

Photo cartridge
buying, 74
replacing, 56 to 59
safety instructions, 8

PictBridge, 11, 43
PictureMate PicturePack, 74
P.I.F. Frame, 38
PIM (PRINT Image Matching), 11
Power cable, 60
Problems

memory card, 68
missing colors, 70
paper feeding, 70 to 71
paper jam, 70
print quality, 69 to 70

Q

Quality, 69 to 70

R

Removing
memory card, 22
photo cartridge, 56

Resolution, 12

S

Save photos, 53
SD (Secure Digital) card, 20

Sepia, 14
Setup problems, 68
Smears, 69

T

Technical support, 72
Thumb drive

printing from, 41
saving files to, 53

TIFF, 12
Transporting PictureMate, 60
Troubleshooting, 66 to 71

U

USB cable, 44, 60
USB DP (USB Direct Print), 11, 43
User’s Guide, 13

X

xD Picture Card, 20

Z

Zip disk
printing from, 41
saving files to, 53
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